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MODULE 2: INSTALLATION REQUIREMENTS 

Module Overview 
Microsoft Dynamics® NAV 2013 takes advantage of the Microsoft software 
platform. Therefore, all the software prerequisites of Microsoft Dynamics NAV 
2013 are part of the Microsoft software stack. This software platform consists of 
the following prerequisites for Microsoft Dynamics NAV 2013: 

• Windows Server 2008, Windows Server 2008 R2 and Windows Server 
8  

• Microsoft SQL Server™ 2008, Microsoft SQL Server 2008 R2 or 
Microsoft SQL Server 2012  

• The Microsoft® .NET Framework 3.5  

• Microsoft Windows Web Services Enhancements  

• Microsoft Report Viewer 2010 

These software requirements determine the hardware configuration. The 
hardware configuration must be sufficient to run the software prerequisites. If this 
is not the case then the software prerequisites do not run correctly. This leads to a 
failed implementation of Microsoft Dynamics NAV. 

Objectives 

The objectives are:  

• Understand the operating system and software prerequisites for 
Microsoft Dynamics NAV 2013. 

• Select the correct Microsoft Windows® Server Edition for the core 
components. 

• Select the correct Microsoft SQL Server edition for the Microsoft 
Dynamics NAV 2013 environment. 
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Software Prerequisites for Microsoft Dynamics NAV 
2013 

Install and configure the following to prepare the server on which you will load 
Microsoft Dynamics NAV: 

• Windows Server 2008 is the infrastructure platform for powering 
connected applications, networks, and web services from the 
workgroup to the data center.  

• Microsoft SQL Server is a comprehensive database platform 
providing enterprise-class data management with integrated business 
intelligence (BI) tools. The Microsoft SQL Server 2008 database engine 
provides improved security and reliable storage for both relational 
and structured data. This enables you to build and manage highly 
available, performance data applications for use in your business. 

• The .NET Framework is a development and execution environment 
that enables different programming languages and libraries to work 
together seamlessly to create Microsoft Windows-based applications 
that are easier to build, manage, deploy, and integrate with other 
networked systems. 

• The Web Services Enhancements for Microsoft .NET is an add-in to 
Microsoft Visual Studio® and the Microsoft .NET Framework 3.5 that 
enables developers to build secure web services that are based on the 
latest web services protocol specifications. 

The Microsoft Report Viewer 2010 redistributable package includes Windows 
Forms and ASP.NET Web server controls for viewing reports designed by using 
Microsoft reporting technology. Microsoft Report Viewer control enables 
applications that run on the .NET Framework to display reports designed by using 
Microsoft reporting technology.  

Windows Server 2008 and Windows Server 2008 R2 

Windows Server 2008 is a multipurpose server designed to increase the reliability 
and flexibility of the server or private cloud infrastructure, helping you save time 
and reduce costs. It gives you powerful tools to react to business needs faster than 
ever with more control and confidence.  

Windows Server 2008 R2 delivers many improvements for you to implement a 
robust datacenter and desktop virtualization plan. Whether you want to combine 
servers, build a private cloud, or offer virtual desktop infrastructure (VDI), the 
features of Windows Server 2008 R2 help you take your datacenter and desktop 
strategy to a new level. 
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Windows Server 2008 and Windows Server 2008 R2 come in different editions. 
Each edition provides key functionality to support any size business and IT 
challenge.  

The figure Windows Server 2008 Roles per Edition illustrates: 

 

FIGURE 2.1: WINDOWS SERVER 2008 ROLES PER EDITION WINDOW 

Windows Server 2008 Datacenter Edition 

Windows Server 2008 R2 Datacenter delivers an enterprise-class platform to 
deploy business-critical applications and large-scale virtualization on small and 
large servers. It helps you with the following:  

• Improve availability, enhance power management, and integrate 
solutions for mobile and branch workers.  

• Reduce infrastructure costs by combining applications that have 
unlimited virtualization licensing rights.  

• Scale from two to 64 processors.  

Windows Server R2 2008 Datacenter provides a foundation on which to build 
enterprise-class virtualization and scale-up solutions.  
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Windows Server 2008 Enterprise Edition 

Windows Server 2008 R2 Enterprise is an advanced server platform that provides 
more cost-effective and reliable support for mission-critical workloads. It offers 
innovative features for virtualization, power savings, and manageability and helps 
make it easier for mobile workers to access company resources. 

Windows Server 2008 Standard Edition 

Windows Server 2008 R2 Standard is the most robust Windows Server operating 
system to date. With built-in, improved web and virtualization capabilities, it 
increases the reliability and flexibility of the server infrastructure while helping to 
save time and reduce costs. Powerful tools give you more control over the servers 
and streamline configuration and management tasks. Plus, enhanced security 
features work to harden the operating system to help protect your data and 
network and provide a solid, highly dependable foundation for your business. 

Windows Server 2008 R2 also offers four special purpose editions. 

Windows Server 2008 R2 Web Edition 

Windows Web Server 2008 R2 is a powerful web application and services platform. 
Featuring Internet Information Services (IIS) 7.5 and designed exclusively as an 
Internet-facing server, it offers improved administration and diagnostic tools to 
help reduce infrastructure costs when you use it with different popular 
development platforms. With included Web server and DNS server roles, in 
addition to improved reliability and scalability, this platform helps you manage 
the most demanding environments — from a dedicated web server to a whole 
web server farm. 

Windows Server 2008 R2 HPC Edition 

Windows HPC Server 2008 R2, the Microsoft third-generation HPC solution, 
provides a comprehensive and cost-effective solution for harnessing the power of 
high-performance computing. Out-of-the-box, world-class performance, and 
scalability enable organizations of all sizes to rapidly deploy solutions ranging 
from personal HPC workstations to large clusters spanning thousands of nodes. 
Customers can lower both their operating and capital costs. Windows HPC Server 
2008 R2 integrates easily with existing IT infrastructure to enable end-users to 
access HPC resources by using familiar Windows-based technologies. With a 
tightly integrated set of dedicated cluster and parallel development tools, 
anchored around Visual Studio 2010, developers can build robust and scalable 
HPC applications easily and quickly. Windows HPC Server 2008 R2 is 
complemented by a rich ecosystem of SI, ISV, and OEM partners to make sure that 
customers have access to the applications of their choice and the resources 
required to successfully run them. 
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Windows Server 2008 R2 for Itanium-based Systems 

Windows Server 2008 R2 for Itanium-based systems delivers an enterprise-class 
platform to deploy business-critical applications. With it, you can scale database, 
line-of-business, and custom applications to meet growing business needs. 
However, note that Windows Server 2008 R2, SQL Server 2008 R2, and the current 
2010 line-up of developer tools, plus associated .NET frameworks, will be the last 
iterations in each product line to support the Intel Itanium processor and 
associated OEM server platforms. Microsoft Dynamics NAV 2013 does not support 
this Windows Server edition. 

Windows Server 2008 R2 Foundation Edition 

Windows Server 2008 R2 Foundation is a cost-effective, entry-level technology 
foundation targeted at small business owners and IT generalists who support 
small businesses. Foundation is an inexpensive, easy-to-deploy, proven, and 
reliable technology that provides organizations with the foundation to run the 
most prevalent business applications and share information and resources. 

For more information about Windows Server 2008 and the different editions and 
features in each edition, see http://www.microsoft.com/windowsserver/. 

Windows Small Business Server 2008 

Designed and priced for small businesses with up to 75 users, Windows Small 
Business Server 2008 delivers enterprise-class server technology in an affordable, 
all-in-one solution. It helps protect your business information from loss by 
performing automatic daily backups. Additionally, it helps users be more 
productive with features such as email, Internet connectivity, internal websites 
(collaboration), remote access, and file and printer sharing. 

For more information about Microsoft Windows Small Business Server, see 
http://www.microsoft.com/sbs/. 

Windows Essential Business Server 2008 

Windows Essential Business Server (EBS) combines several Microsoft technologies 
to meet the needs of businesses with up to 300 users or computers. With 
Windows EBS, businesses benefit from the power and versatility of a multiserver, 
multi-computer network, and IT administrators enjoy reduced installation time 
and complexity. Administrators can perform most of their daily operations tasks 
from a single, integrated console. Administrators can also connect remotely to the 
Windows EBS Administration Console. 
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    Note: Some core components and clients such as the Microsoft Dynamics 
NAV Server and the Microsoft Dynamics NAV Portal Framework for SharePoint® 
2010 can only be installed on 64 bit editions.  
 
The Microsoft Dynamics NAV Server Administration Tool does not run on Windows 
Server 2008. It does run on Windows Server 2008 R2. 

SQL Server 2008 

Microsoft SQL Server is a comprehensive database server and information 
platform offering a complete set of enterprise-ready technologies and tools that 
help people derive the most value from information at the lowest total cost of 
ownership. Enjoy high levels of performance, availability, and security, use more 
productive management and development tools, and deliver widespread insight 
with self-service business intelligence (BI).  

SQL Server 2008 R2 delivers several breakthrough capabilities that will help 
organizations to scale database operations with confidence, improve IT and 
developer efficiency, and enable highly scalable and well-managed business 
intelligence on a self-service basis for users. 

The Microsoft SQL Server database engine is the core of this enterprise data 
management solution. Additionally, Microsoft SQL Server offers analysis (business 
intelligence with SQL Server Analysis Services), reporting (SQL Server Reporting 
Services), integration (SQL Server Integration Services), and notification 
functionalities. The figure The Microsoft SQL Server Platform shows the SQL Server 
platform context: 
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FIGURE 2.2: THE MICROSOFT SQL SERVER PLATFORM WINDOW 

Microsoft SQL Server 2008 and SQL Server 2008 R2 come in different editions 
offering key functionalities to support any business size and IT strategy. SQL 
Server 2008 editions are available for both 32-bit and 64-bit platforms. However, 
Microsoft SQL Server 2008 R2 is available only for the 64-bit platform.  

    Note: Microsoft Dynamics NAV 2013 supports the 64-bit editions of both 
Microsoft SQL Server 2008 and Microsoft SQL Server 2008 R2.  

SQL Server 2008 R2 Enterprise Edition 

Enterprise Edition is meant to support the largest enterprise online analytical 
processing environments, highly complex data analysis, data warehousing, and 
active web servers. 
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SQL Server 2008 R2 Standard Edition 

Standard Edition includes the necessary functionality for e-commerce, data 
warehousing, and line-of-business solutions that most small- and medium-sized 
business use. If your organization has to track large amounts of data but does not 
have to have all the functionality of Enterprise Edition, then Standard Edition will 
work well with Microsoft Dynamics NAV. 

SQL Server 2008 R2 Workgroup Edition 

Workgroup Edition is the data management solution for small organizations that 
need a database that has no limit on the size or number of users and can work as 
a back end to small web servers and departmental or branch office operations. 

SQL Server 2008 R2 Express Edition 

SQL Server 2008 R2 Express Edition is a free, easy-to-use and easy-to-manage 
database that can be redistributed to act as a client database and basic server 
database. It is usually suited for small data sets and will not work in some 
Microsoft Dynamics NAV implementations. 

To determine which SQL Server edition will work best for the Microsoft Dynamics 
NAV 2013 implementation, review the features in each edition.  

For more information about the features in each edition, see 
http://www.microsoft.com/sqlsverer/.  

SQL Server 2012 

SQL Server 2012 will provide Mission Critical Confidence with greater uptime, 
blazing-fast performance and enhanced security features for mission critical 
workloads. SQL Server 2012 provides both Breakthrough Insight with managed 
self-service data exploration and stunning interactive data visualizations 
capabilities and Cloud On Your Own Terms by enabling the creation and 
extension of solutions across on-premises and public cloud. SQL Server 2012 will 
be available in three main editions: 

• Enterprise Edition 

• Business Intelligence Edition 

• Standard Edition 

For more information about SQL Server 2012 editions and the corresponding 
features, please see http://www.microsoft.com/sqlserver/. 
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.NET Framework 

The .NET Framework is an integral Windows component that supports building 
and running the next generation of applications and web services. The .NET 
Framework fulfills the following objectives:  

• Provides a consistent object-oriented programming environment 
whether object code is stored and executed locally, executed locally 
but Internet-distributed, or executed remotely. 

• Provides a code-execution environment that minimizes software 
deployment and versioning conflicts. 

• Provides a code-execution environment that promotes safe execution 
of code, including code created by an unknown or semi-trusted third 
party. 

• Provides a code-execution environment that eliminates the 
performance problems of scripted or interpreted environments. 

• Makes the developer experience consistent across widely varying 
types of applications, such as Windows-based applications and web-
based applications. 

• Builds all communication on industry standards to make sure that 
code based on the .NET Framework can integrate with any other 
code. 

The .NET Framework has two main components: the common language runtime 
and the .NET Framework class library. The common language runtime is the 
foundation of the .NET Framework. You can think of the runtime as an agent that 
manages code at execution time. It provides core services such as memory 
management, thread management, and remoting, while also enforcing strict type 
safety and other forms of code accuracy that promote security and robustness. In 
fact, the concept of code management is a fundamental principle of the runtime. 
Code that targets the runtime is known as managed code, whereas code that does 
not target the runtime is known as unmanaged code. The class library, the other 
main component of the .NET Framework, is a comprehensive, object-oriented 
collection of reusable types that you can use to develop applications ranging from 
traditional command-line or graphical user interface (GUI) applications to 
applications that are based on the latest innovations provided by ASP.NET, such as 
Web Forms and Web services. 

More information on the .NET Framework can be found on 
http://www.microsoft.com/net/. 
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Service Accounts 

When you install Microsoft Dynamics NAV Server, the service logs on by using the 
NT Authority\Network Service account by default. This is a shared account that 
can be used by other unrelated network services. Any users who have rights to this 
account have rights to all services that are running on this account.   

We recommend that you configure Microsoft Dynamics NAV Server (and 
Microsoft SQL Server) to log on by using a dedicated Windows domain user 
account instead. This account should not be an administrator either in the domain 
or on any local computer. You can use the same user account for both Microsoft 
SQL Server and Microsoft Dynamics NAV Server, but this is optional. 

A dedicated domain user account is considered more secure because no other 
services and therefore no other users have permissions for this account. In 
addition, a domain user account offers more flexibility when you perform file read 
and/or write operations on the network. You can easily define the necessary 
permissions for the domain user account, because it is known on all computers in 
the domain. 

If you want to run the Microsoft Dynamics NAV Server under a domain user 
account, you must: 

• Enable the account to log on as a service. 

• Enable the account to register a service principal name (SPN) on itself 
(or register the SPN manually). 

• Give the account necessary database privileges in SQL Server. 

Remember that membership in the local Administrators group, or equivalent, is 
the minimum required to complete these procedures. 

Enable the account to log on as a service 

Depending on various factors, the account may already have this ability. For 
example, if you have already installed SQL Server and configured it to run under 
the same account, SQL Server will have modified the account to log on as a 
service. If not, you can enable the account by following this procedure: 

1. Click Start, point to Run, type "mmc", and then click OK. 
2. On the File menu, click Add/Remove Snap-in. 

3. In Add/Remove Snap-in, click Add, and then, in Add Standalone 
Snap-in, double-click Group Policy Object Editor. 

4. In Group Policy Object, click Browse, browse to the Group Policy 
object (GPO) that you want to modify, click OK, and then click Finish. 

5. Click Close, and then click OK.  
6. In the console tree, click User Rights Assignment. 
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7. In the details pane, double-click Log on as a service.  
8. If the security setting has not yet been defined, select the Define 

these policy settings check box. 
9. Click Add User or Group, and then add the appropriate account to 

the list of accounts that have the Log on as a service right. 

Enable the Microsoft Dynamics NAV Server account to register an 
SPN on itself 

To enable secure mutual authentication between clients and Microsoft Dynamics 
NAV Server, you must configure the Microsoft Dynamics NAV Server account to 
self-register SPNs. Mutual authentication is recommended in a production 
environment but may not be necessary in a testing or staging environment. The 
following procedure assumes you are working with a computer that is running 
Windows Server 2008 or Windows Server 2008 R2. On Windows 7 or Windows 
Vista, you would have to install the Remote Server Administration Tools first. 

1. Start the Active Directory® Users and Computers snap-in in Microsoft 
Management Console (MMC): 

a. Click Start > Run, on the command line type "mmc", and then 
click OK. 

b. When the console opens, click File > Add/Remove Snap-In, select 
Active Directory Users and Computers, and then click Add.  
If you do not see Active Directory Users and Computers in the list 
of available snap-ins, you may have to use Server Manager to 
install the Active Directory Domain Services role on the server. 
 

2. In MMC, select Active Directory Users and Computers in the tree 
view, and then on the View menu click Advanced Features. 

3. Expand the domain node in the tree view, and then click Users. 

4. Right-click the service account, select Properties, and then click the 
Security tab. 

5. In the Group or user names list, click SELF. 
6. Under Permissions for SELF, in the lower part of the panel, scroll 

down to Write public information, and then click to put a check 
mark in the Allow column. 

7. Click OK to exit the Properties panel, and close Active Directory 
Users and Computers. 
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Give the account necessary database privileges on SQL Server 

To grant the necessary SQL Server database privileges to the service account, do 
the following: 

1. Start SQL Server Management Studio, and connect to the appropriate 
Microsoft Dynamics NAV Server instance. 

2. Browse the tree view: Databases, <your database>, Users. 
3. If the Microsoft Dynamics NAV Server is listed, right-click it and click 

Properties. If the Microsoft Dynamics NAV Server account is not 
listed, follow these steps:  

a. Right-click Users and choose New User. 
b. On the right side of the second line in the Database User – New 

dialog box, click the ellipsis button (...). 
c. Enter or browse for identifying information for an existing SQL 

Server Login.  
 

4. In the Database role membership field at the bottom of the 
Database User dialog box, select the db_owner role. (Instead of 
assigning the db_owner role, you can assign the datareader, 
datawriter and ddladmin roles.) 

5. Click OK to exit the Database User dialog box. 
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SQL Server Database Components 
SQL Server Database Components configure Microsoft SQL Server to work with 
Microsoft Dynamics NAV 2013. Database components include an edition of SQL 
Server and a Microsoft Dynamics NAV 2013 database. For production 
environments, we recommend that you use the Enterprise, Standard, or 
Workgroup Edition of SQL Server 2012, SQL Server 2008 R2 or SQL Server 2008. 

System Requirements 

The minimum system requirements for the Microsoft Dynamics NAV 2013 
Database Components for SQL Server are as follows: 

Domain Description 

SQL Server The database components run on the following 
versions and editions of SQL Server: 
• Microsoft SQL Server 2008 R2 Express, 

Workgroup, Standard, or Enterprise (64-bit 
editions only). 

• Microsoft SQL Server 2008 Express, 
Workgroup, Standard, or Enterprise (64-bit 
editions only). 

The 64-bit edition of SQL Server 2008 R2 
Express is automatically installed before the 
Microsoft Dynamics NAV 2013 database 
components by Microsoft Dynamics NAV 2013 
Setup if a supported SQL Server product is not 
already installed on the destination computer. 

 

  

Microsoft Official Training Materials for Microsoft Dynamics ® 
Your use of this content is subject to your current services agreement 

 



Installation and Configuration in Microsoft Dynamics® NAV 2013 

2 - 14 

Microsoft Dynamics NAV Server 
The Microsoft Dynamics NAV Server can be installed on 64-bit editions of 
Windows Server 2008 and Windows 2008 R2. Although Microsoft Dynamics NAV 
Server can be installed on Windows Server 2008, the Microsoft Dynamics NAV 
Server Administration Tool can only run on Windows Server 2008 R2.  

System Requirements 

The minimum system requirements for Microsoft Dynamics NAV Server are as 
follows: 

Domain Description 

Operating system Microsoft Dynamics NAV Server runs only on 
64-bit editions of the following versions of 
Windows:  
• Windows 7 Professional, Enterprise, or 

Ultimate (64-bit editions only) 

• Windows Server 2008 R2 

• Windows Server 2008 (64-bit edition only) 

• Windows Server 8 

    Note: The Microsoft Dynamics NAV 
Server Administration Tool does not run on 
Windows Server 2008. It does run on Windows 
Server 2008 R2.  

 

Hardware resources Hard disk space: 
• 50 MB 

Memory: 
• 2 GB 

Installing additional language modules requires 
additional disk space on the Microsoft 
Dynamics NAV server tier (approximately 7 MB 
per language).  
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Domain Description 

Additional software • Microsoft .NET Framework 4.0: Microsoft 
Dynamics NAV 2013 Setup installs this 
software if it is not already present on the 
destination computer. 

• Active Directory is required for the 
Microsoft Dynamics NAV Portal Framework 
for Microsoft SharePoint 2010.   

• Windows PowerShell 2.0 is required for the 
command-line API for Microsoft Dynamics 
NAV Administration. Windows PowerShell 
2.0 is included with Windows Server 2008 
R2 and Windows 7.  

• Microsoft Report Viewer 2010 is required 
for Save as Excel or Save as PDF 
functionality.  
Microsoft Dynamics NAV 2013 Setup 
installs this software if it is not already 
present on the destination computer. 

RoleTailored Client for Windows 
Microsoft Dynamics NAV 2013 supports multiple client options, each having 
different hardware and/or software requirements. 

System Requirements 

The minimum system requirements for the RoleTailored client are as follows: 

Domain Description 

Operating system The RoleTailored client runs on the following 
versions of Windows: 
• Windows 7 Professional, Enterprise, or 

Ultimate (32-bit or 64-bit editions) 

• Windows 8 

• Windows Server 2008 R2 

• Windows Server 2008 (32-bit or 64-bit 
editions) 

On 64-bit editions of Windows, the 
RoleTailored client runs in WOW64 emulation 
mode. 
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Domain Description 

Hardware resources Hard disk space: 
• 30 MB 

Memory: 
• 1 GB 

Installing additional language modules will 
require additional disk space on the client 
(approximately 35 MB per language) and on 
the Microsoft Dynamics NAV server tier 
(approximately 7 MB per language).  

Additional software • Microsoft .NET Framework 4.0. 

• Microsoft Lync 2010 or Microsoft Office 
Communicator 2007 is required for instant 
messaging and TAPI. 

• Microsoft Office 2010 or Microsoft Office 
2007 SP1 is required for mail merge, 
Outlook® client integration, budget 
import and export to and from Microsoft 
Excel® and Office XML, and SharePoint 
links. 

• Microsoft Office 2010 is required for 
OneNote integration. 

• Collaboration data objects (CDO) are 
required for mail merge and email 
logging. 
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Domain Description 

Reports You design and upgrade reports by using the 
Microsoft Dynamics NAV development 
environment. By default, the development 
environment is installed with the RoleTailored 
client. You run reports in the RoleTailored 
client or on Microsoft Dynamics NAV Server. 

• Microsoft Visual Studio 2010 SP1 
Professional, Premium, or Ultimate and 
Microsoft Report Viewer 2010 SP1 are 
required for designing reports in the 
development environment.  
 
Microsoft Dynamics NAV Setup installs 
Microsoft Report Viewer 2010 SP1 if it is 
not already on the destination computer. 

• Microsoft SQL Server 2008 R2 Report 
Builder 3.0 or Microsoft SQL Server 2008 
R2 RTM Express with Advanced Services 
with BIDS installed is required to update 
reports in the development environment. 

Microsoft Dynamics NAV Setup installs 
Microsoft SQL Server 2008 R2 Report 
Builder 3.0 if neither of these products is 
already installed on the destination 
computer. Setup only installs Microsoft 
SQL Server 2008 R2 Report Builder 3.0 
when the development environment is 
included in the installation. 

• Microsoft Report Viewer 2010 SP1 is 
required for running reports in the 
RoleTailored client or on Microsoft 
Dynamics NAV Server. 
Microsoft Dynamics NAV Setup installs 
this software if it is not already installed on 
the destination computer. 

    Note: Microsoft Dynamics NAV 2013 Setup can only install the Excel add-in if 
Excel 2010 is present on the destination computer.  
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Microsoft Dynamics NAV Web Client 
With the Microsoft Dynamics NAV Web client, you can access Microsoft Dynamics 
NAV data over the Internet. From a web browser, you can view and edit data by 
using an interface that resembles the RoleTailored client. 

System Requirements 

The minimum system requirements for the Web client are as follows: 

Domain Description 

Server component • Microsoft .NET Framework 4.0. 
Microsoft Dynamics NAV Setup installs this 
software if it is not already present on the 
destination computer. 

• Internet Information Server 7.0. 

Supported browsers There are no known issues with these browsers: 

• Internet Explorer® 9 or Internet Explorer 8 
on Windows 7, Windows Server 2008 R2, or 
Windows Server 2008 (32-bit or 64-bit 
editions).  

Supported with limitations:  

• Google Chrome 16 on Windows 7, 
Windows Server 2008 R2, or Windows 
Server 2008 (32-bit or 64-bit editions). 

• Mozilla Firefox 9 on Windows 7, Windows 
Server 2008 R2, or Windows Server 2008 
(32-bit or 64-bit editions). 

 

Microsoft Dynamics NAV Portal Framework for 
Microsoft SharePoint 2010 

Microsoft Dynamics NAV Portal Framework is a set of components that you install 
on a server or servers that run Microsoft SharePoint Foundation 2010. Microsoft 
Dynamics NAV Portal Framework for Microsoft SharePoint 2010 provides access 
to Microsoft Dynamics NAV data from Microsoft SharePoint 2010 applications 
without requiring additional or specialized development work. 
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System Requirements 

The minimum system requirements for the Microsoft Dynamics NAV Portal 
Framework for SharePoint 2010 are as follows: 

Domain Description 

Operating system Microsoft Dynamics NAV Portal Framework for 
Microsoft SharePoint 2010 runs on the 
following versions of Windows: 
• Windows Server 2008 R2. 

• Windows Server 2008 (64-bit editions only). 

 

Additional software • Microsoft .NET Framework 3.5 SP1.  
Microsoft Dynamics NAV 2013 Setup 
installs this software if it is not already 
present on the destination computer. 

• Microsoft SharePoint Foundation 2010 or 
SharePoint Server 2010. 

• SQL Server 2008 R2 (64-bit editions only) 
or SQL Server 2008 (64-bit editions only). 

 

Supported browsers There are no known issues with these browsers: 
• Internet Explorer 9 or Internet Explorer 8 

on Windows 7, Windows Server 2008 R2, or 
Windows Server 2008 (32-bit or 64-bit 
editions).  

Supported with limitations: 

• Google Chrome 16 on Windows 7, 
Windows Server 2008 R2, or Windows 
Server 2008 (32-bit or 64-bit editions). 

• Mozilla Firefox 9 on Windows 7, Windows 
Server 2008 R2, or Windows Server 2008 
(32-bit or 64-bit editions). 
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Microsoft Dynamics NAV Business Web Services 
Microsoft Dynamics NAV business web services offer a way to make application 
functionality available to many external systems and users. 

System Requirements 

The minimum system requirements for the Microsoft Dynamics NAV business web 
services are as follows: 

Domain Description 

Additional software • Microsoft Visual Studio 2010 or Microsoft 
Visual Studio 2008. 

• Microsoft .NET Framework 4.0.  

    Note: You can use most web service-enabled products with Microsoft 
Dynamics NAV web services. However, some products may be unable to deal with 
more complex web service functionality and complex XML structures, such as 
extension codeunits.   

Automated Data Capture System (ADCS) 
Automated Data Capture System (ADCS) enables accurate data to be captured 
with online wireless devices. 

System Requirements 

The minimum system requirements for the ADCS for Microsoft Dynamics NAV 
2013 are as follows: 

Domain Description 

Additional software • MSXML version 6.0. 

• Telnet or Microsoft Windows 
HyperTerminal. VT100 Plug-in, which acts 
as a virtual Telnet server and is required for 
each computer on which you install ADCS.  

• Microsoft Loopback Adapter. 

    Note: HyperTerminal is no longer included with Windows. For more 
information, see What happened to HyperTerminal? in the Windows Help.  
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Lab 2.1: Install the Three Tiers on Three Computers 
Scenario 

Tim, the IT administrator at Contoso, wants to install a Microsoft Dynamics NAV 
2013 environment for testing After becoming familiar with the product 
architecture, he analyzes the system requirements and the available hardware. He 
then decides to install the three tiers on three separate servers. He will use a new 
domain user account as service account for the Microsoft Dynamics NAV Server. 

Computer Name Comment 

DYN-NAV-SQL This server will be used as the data tier.  
This server runs Windows Server 2008 R2. No 
edition of SQL Server 2008 is currently installed. 

DYN-NAV-SRV This server will host the Microsoft Dynamics 
NAV server tier. 
It runs Windows Server 2008 R2.   

DYN-NAV-CLT This computer will host the RoleTailored client 
as the client tier. It runs Windows 7 Professional 
(64-bit edition) with Microsoft Office 2010 
installed. 

Exercise 1: Provision a Service Account 
Exercise Scenario 

Before he starts the installation of the data and the server tier, Tim creates a new 
domain user account to use as a service account. 

Task 1: Create a Service Account 

High Level Steps 
1. Create a service account in Active Directory. 

Detailed Steps 
1. Create a service account in Active Directory. 

a. Click Start, and then click Administrative Tools, Active Directory 
Users and Computers. 

b. In the left tree view pane, expand the contoso.com node. 

c. In the left navigation pane, right-click the Managed Service 
Accounts node. 

d. In the shortcut menu that opens, select New > User. 
e. In the New Object – User window, in the Full Name field, enter 

NAV Service Account. 
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f. Enter NAV2013svc in the User Logon Name text box. 
g. Click Next. 
h. In the Password field, type the password for the new account: 

"Pa$$w0rd". 
i. In the Confirm password field, type the password again:  

"Pa$$w0rd". 

j. Clear the User must change password at next logon option. 
k. Select the Password never expires option. 
l. Click Next > Finish to create the user.  
m. Close Active Directory Users and Computers. 

Task 2: Grant the Logon as a Service Permission 

High Level Steps 
1. Grant the logon as a service permission. 

Detailed Steps 
1. Grant the logon as a service permission. 

a. Click Start, and then click Administrative Tools, Group Policy 
Management. 

b. In the left tree view pane, expand the contoso.com node. 
c. In the left navigation pane, expand the Domains node. 

d. Expand the Group Policy Objects node. 
e. Right-click the Default Domain Controllers Policy object, and 

then click Edit. 
f. In the Group Policy Management Editor window, select 

Computer Configuration, Policies, Windows Settings, Security 
Settings, Local Policies, User Rights Assignment. 

g. In the right side pane, double-click Logon as a service. 

h. Select the Define these policy settings option. 
i. Click Add User or Group. 
j. In the Add User or Group window, enter 

CONTOSO\NAV2013Svc, and then click OK. 

k. Click Apply to add the account to the list of accounts that have 
the logon as a service right. 

l. Close the Group Policy Management Editor. 
m. Close Group Policy Management. 
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Exercise 2: Install SQL Server Database Components 
Exercise Scenario 

As a first step in the installation, Tim installs the data tier on the DYN-NAV-SQL 
server. Because it is not a production environment, Tim decides to install the SQL 
Server Express Edition. He will use the CONTOSO\NAV2013svc account as service 
account for the Microsoft Dynamics NAV Server. 

Task 1: Logon to the Server as Administrator 

High Level Steps 
1. Logon to the server as Administrator. 

Detailed Steps 
1. Logon to the server as Administrator. 

a. On the desktop, press CTRL+ALT+DEL. 

b. In the Password field, enter the password for the Administrator 
user: 
"Pa$$w0rd". 

c. Press ENTER (or click the arrow icon at the right side of the 
Password field). 

Task 2: Start Microsoft Dynamics NAV Setup 

High Level Steps 
1. Insert the Microsoft Dynamics NAV 2013 product DVD in the DVD 

drive. 

2. Start Microsoft Dynamics NAV 2013 Setup. 

Detailed Steps 
1. Insert the Microsoft Dynamics NAV 2013 product DVD in the DVD 

drive. 
a. Open the DVD drive by pressing the Eject button on the physical 

drive. 
b. Put the DVD on the tray. 

c. Press the Close button to close the DVD drive. 
 

2. Start Microsoft Dynamics NAV 2013 Setup. 
a. Open Windows Explorer. 

b. Click Computer to see a list of available drives. 
c. Select the DVD drive that contains the product DVD.  
d. In the root folder of the selected drive, double-click setup.exe. 

If the Open File - Security Warning dialog box pops up (asking 
whether you want to run the setup.exe application), click Run. 
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Task 3: Select the Installation Option 

High Level Steps 
1. Select the installation option. 

Detailed Steps 
1. Select the installation option. 

a. In the Welcome to the Microsoft Dynamics NAV 2013 Setup 
window, click Next. 

b. On the Microsoft Software License Terms page, click I Accept.  
c. On the Microsoft Dynamics NAV Setup page, click Choose an 

Installation Option. 
d. On the Choose an installation option page, click Custom. 

e. On the Customize the installation page, click the icon at the left 
of the SQL Server Database Components node. 

f. Click Run All from My Computer. 
g. Click Next. 
h. On the Specify parameters page, in the Service Account field, 

enter CONTOSO\NAV2013svc. (If the selected account does not 
have the logon as a service right, an error message will be 
displayed. In that case, you must assign the necessary permissions 
to the specified account before you can continue.) 

i. On the Specify parameters page, in the SQL Database field, 
enter NAV_DEMO2013.  

j. Click Apply.  
If no SQL Server Edition is installed on the server or if the 
NAVDEMO instance cannot be found, Setup will display a 
warning message and will suggest installing SQL Server Express 
Edition.  

k. Click OK to start the installation. 

Task 4: Close the Setup Wizard 

High Level Steps 
1. Close Microsoft Dynamics NAV 2013 Setup. 

Detailed Steps 
1. Close Microsoft Dynamics NAV 2013 Setup. 

a. Click Close to close the setup wizard. 
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Task 5: Verify Installation 

High Level Steps 
1. Verify the installation result. 

Detailed Steps 
1. Verify the installation result. 

a. Click Start in the Windows taskbar. 
b. Click All Programs, Administrative Tools, Services. 

c. In the Services management console, browse the list of services in 
the right side pane. 
The list should now include a service named “SQL Server 
(NAVDEMO)” 

d. Check that the Status column for the Microsoft Dynamics NAV 
Server is Started. 

Exercise 3: Install Microsoft Dynamics NAV Server 
Exercise Scenario 

After he installs the SQL Server database components, Tim continues to install the 
server tier on the DYN-NAV-SRV server. 

Task 1: Log on to the Server as Administrator 

High Level Steps 
1. Log on to the server as administrator. 

Detailed Steps 
1. Log on to the server as administrator. 

a. On the desktop, press CTRL+ALT+DEL. 
b. In the Password field, enter the password for the Administrator 

user: 
Pa$$w0rd 

c. Press ENTER (or click the arrow icon at the right side of the 
Password field. 
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Task 2: Start Microsoft Dynamics NAV Setup 

High Level Steps 
1. Insert the Microsoft Dynamics NAV 2013 Product DVD in the DVD 

drive. 

2. Start Microsoft Dynamics NAV 2013 Setup. 

Detailed Steps 
1. Insert the Microsoft Dynamics NAV 2013 Product DVD in the DVD 

drive. 
a. Open the DVD drive by pressing the Eject button on the physical 

drive. 
b. Put the DVD on the tray. 

c. Press the Close button to close the DVD drive. 
 

2. Start Microsoft Dynamics NAV 2013 Setup. 
a. Open Windows Explorer. 

b. Select Computer in the left pane to see a list of available drives. 
c. Select the DVD drive that contains the product DVD.  
d. In the root folder of the selected drive, double-click setup.exe. 

If the Open File - Security Warning dialog box pops up (asking 
whether you want to run the setup.exe application), click Run. 

Task 3: Select the Installation Option 

High Level Steps 
1. Select the installation option. 

Detailed Steps 
1. Select the installation option. 

a. In the Welcome to the Microsoft Dynamics NAV 2013 Setup 
window, click Next. 

    Note: When you install the second and the third tier on the same computer, 
Microsoft Dynamics NAV Setup will start in Maintenance mode. The setup interface 
can be a bit different in that case. (See also the instructor notes.) 

b. On the Microsoft Software License Terms page, click I Accept.  
c. On the Microsoft Dynamics NAV Setup page, click Choose an 

Installation Option. 

d. On the Choose an installation option page, click Custom. 
e. On the Customize the installation page, click the icon at the left 

of the Server node. 

f. Select Run All from My Computer. 
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g. Click Next. 
h. On the Specify parameters page, in the Service Name field, 

enter DynamicsNAV2013. 
i. In the Account Password field, enter the password for the 

CONTOSO\NAV2013svc account.  

If you have chosen to install SQL Server Express Edition, go to step 13. If you have 
installed another edition of Microsoft SQL Server  

j. On the Specify parameters page, in the SQL Server field, enter 
the name of the computer running SQL Server. 

k. On the same page, in the SQL Server Instance field, enter 
NAV_DEMO.  

l. On the Specify parameters page, in the SQL Database field, 
enter NAV_DEMO2013.  

m. Click Apply to start the installation. 
 
If Microsoft .NET Framework 4.5 is not installed on the server, 
Setup will install this automatically. 

Task 4: Close the Setup Wizard 

High Level Steps 
1. Close Microsoft Dynamics NAV 2013 Setup. 

Detailed Steps 
1. Close Microsoft Dynamics NAV 2013 Setup. 

a. Select Close to close the setup wizard. 

Task 5: Verify Installation 

High Level Steps 
1. Verify the installation result. 

Detailed Steps 
1. Verify the installation result. 

a. Click Start in the Windows taskbar. 
b. Click All Programs, Administrative Tools, Services. 
c. In the Services management console, browse the list of services in 

the right-side pane. 
The list should now include a service named “Microsoft Dynamics 
NAV Server [DynamicsNAV2013]” 

d. Check that the Status column for the Microsoft Dynamics NAV 
Server is Started. 
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Exercise 4: Install Microsoft Dynamics NAV RoleTailored 
Client for Windows 
Exercise Scenario 

Now that the data and the server tiers are available, Tim installs the RoleTailored 
client on the DYN-NAV-CLT computer. 

Task 1: Log on to the Computer as Administrator 

High Level Steps 
1. Log on to the server as Administrator. 

Detailed Steps 
1. Log on to the server as Administrator. 

a. On the desktop, press CTRL+ALT+DEL. 
b. In the Password field, enter the password for the Administrator 

user: 
Pa$$w0rd. 

c. Press ENTER (or click the arrow icon at the right side of the 
Password field. 

Task 2: Start Microsoft Dynamics NAV Setup 

High Level Steps 
1. Insert the Microsoft Dynamics NAV 2013 product DVD in the DVD 

drive. 
2. Start Microsoft Dynamics NAV 2013 Setup. 

Detailed Steps 
1. Insert the Microsoft Dynamics NAV 2013 product DVD in the DVD 

drive. 
a. Open the DVD drive by pressing the Eject button on the physical 

drive. 
b. Put the DVD on the tray. 
c. Press the Close button to close the DVD drive. 

 

2. Start Microsoft Dynamics NAV 2013 Setup. 
a. Open Windows Explorer. 
b. Select Computer in the left pane to see a list of available drives. 
c. Select the DVD drive that contains the Product DVD.  

d. In the root folder of the selected drive, double-click setup.exe. 
If the Open File - Security Warning dialog box pops up (asking 
whether you want to run the setup.exe application), click Run. 
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Task 3: Select the Installation Option 

High Level Steps 
1. Select the installation option. 

Detailed Steps 
1. Select the installation option. 

a. In the Welcome to the Microsoft Dynamics NAV 2013 Setup 
window, click Next. 

b. On the Microsoft Software License Terms page, click I Accept.  
c. On the Microsoft Dynamics NAV Setup page, click Choose an 

Installation Option. 
d. On the Choose an installation option page, click Client. 
e. On the Customize the installation page, click the icon at the left 

of the Client node. 
f. Select Run from My Computer. 
g. Expand the Client node. 

h. Click the icon at the left of the Microsoft Office Excel Add-in 
node. 

i. Select Run from My Computer. 
j. Click Next. 
k. On the Specify parameters page, in the Server Name field, 

enter the name of the computer running Microsoft Dynamics 
NAV Server.  

l. On the Specify parameters page, verify that the Service Name 
field is set to DynamicsNAV2013.  

m. Click Apply to start the installation. 
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Task 4: Close the Setup Wizard 

High Level Steps 
1. Close Microsoft Dynamics NAV 2013 Setup. 

Detailed Steps 
1. Close Microsoft Dynamics NAV 2013 Setup. 

a. Click Close to close the setup wizard. 

Task 5: Start the RoleTailored Client 

High Level Steps 
1. Start the RoleTailored client. 

Detailed Steps 
1. Start the RoleTailored client. 

a. Click Start in the Windows taskbar. 

b. Click All Programs, Microsoft Dynamics NAV 2013. 
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Module Review 
Module Review and Takeaways 

The software prerequisites of Microsoft Dynamics NAV 2013 consist of the 
Microsoft Stack components including: 

• Windows Server 2008 or Windows Server 2008 R2.  

• Microsoft SQL Server 2008 (64 bit) or Microsoft SQL Server 2008 R2 
(64 bit).  
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